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Feiten

Microsoft heeft kwetsbaarheden verholpen in Windows.

Duiding

Een kwaadwillende kan de kwetsbaarheden misbruiken om aanvallen uit te voeren die kunnen leiden tot de
volgende categorieén schade:

» Denial-of-Service

- Uitvoeren van willekeurige code (root/adminrechten)
- Toegang tot gevoelige gegevens

« Verkrijgen van verhoogde rechten

De ernstigste kwetsbaarheid heeft kenmerk CVE-2025-60724 toegewezen gekregen en bevindt zich in de GDI+
Graphics Component. Deze kwetsbaarheid stelt een kwaadwillende in staat om willekeurige code uit te voeren
op het kwetsbare systeem. Voor succesvol misbruik moet de kwaadwillende het slachtoffer misleiden een
malafide bestand te downloaden en te openen. In beperkte omstandigheden is het voor een kwaadwillende ook
mogelijk om de kwetsbaarheid te misbruiken op bijvoorbeeld een publiek toegankelijke webservice, door het
uploaden van een malfide bestand. Hiervoor is verder geen gebruikerinteractie benodigd.

Windows DirectX:

| CVE-2025-59506 | 7.00
| CVE-2025-60716 | 7.00
| CVE-2025-60723 | 6.30

Verkrijgen van verhoogde rechten |
Verkrijgen van verhoogde rechten |

Denial-of-Service |

Windows Administrator Protection:

| |- R EEEREE |
| CVE-ID | CVSS | Impact |
R RRRREEEE REREEE [ |
| CVE-2025-60718 | 7.80 | Verkrijgen van verhoogde rechten |
| CVE-2025-60721 | 7.80 | Verkrijgen van verhoogde rechten |

Customer Experience Improvement Program (CEIP):

| =omm e | --e- | |
| CVE-ID | CVSS | Impact |
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| CVE-2025-59512 | 7.80

| CVE-2025-62208 | 5.50
| CVE-2025-62209 | 5.50

| CVE-ID | Cvss
R et EECERS
| CVE-2025-59510 | 5.50
| CVE-2025-62452 | 8.00
| CVE-2025-60713 | 7.80
| CVE-2025-60715 | 8.00

Verkrijgen van verhoogde rechten |

Protocol Driver:

Toegang tot gevoelige gegevens |

Toegang tot gevoelige gegevens |

Denial-of-Service |
Uitvoeren van willekeurige code |
Verkrijgen van verhoogde rechten |

|

Uitvoeren van willekeurige code
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Windows Speech:
[
| CVE-ID

[=mmmmm o
| CVE-2025-59507
| CVE-2025-59508
| CVE-2025-59509

R RLCRLTITRITELRITITRETRLRS |
| Impact |
R RLRETETELEEEEEEEETEEEEEETE |
| Verkrijgen van verhoogde rechten |
| Verkrijgen van verhoogde rechten |
| Toegang tot gevoelige gegevens |

Multimedia Class Scheduler Service (MMCSS):

| ________________
| CVE-ID

|
|
R |
| CVE-2025-60707 |

|

Windows Smart Card:

| -memm e |
| CVE-ID |
R et |
| CVE-2025-59505 |

I

Windows TDX.sys:

[=ommmmm o
| CVE-ID

[=ommmm o
| CVE-2025-60720

Windows OLE:

| ________________
| CVE-ID
[
| CVE-2025-60714

Windows Kernel:

[-ommmmmmmioeee s I
| CVE-ID |
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| |- R REEREE
| CVE-2025-62215 | 7.00 | Verkrijgen van verhoogde rechten

| CVE-2025-59515 | 7.00 | Verkrijgen van verhoogde rechten
| CVE-2025-60717 | 7.00 | Verkrijgen van verhoogde rechten

Windows Ancillary Function Driver for WinSock:

Advisory NCSC-2025-0358



TLP:WHITE

| CVE-2025-60719 | 7.00
| CVE-2025-62217 | 7.00
| CVE-2025-62213 | 7.00

| CVE-2025-62218 | 7.00
| CVE-2025-62219 | 7.00

Verkrijgen van verhoogde rechten |
Verkrijgen van verhoogde rechten |

Verkrijgen van verhoogde rechten |

System Driver:

| Verkrijgen van verhoogde rechten |

| Verkrijgen van verhoogde rechten |

| Impact |
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| CVE-2025-60708 | 6.50 | Denial-of-Service |
| -mem e |------ | |
Oplossingen

Microsoft heeft updates beschikbaar gesteld waarmee de beschreven kwetsbaarheden worden verholpen. We
raden u aan om deze updates te installeren. Meer informatie over de kwetsbaarheden, de installatie van de
updates en eventuele work-arounds vindt u op:

https://portal.msrc.microsoft.com/en-us/security-guidance

Kwetsbaarheden
CVE CVSS Score
> CVE-2025-59505 7.8 HIGH
> CVE-2025-59506
> CVE-2025-59507
> CVE-2025-59508
> CVE-2025-59509 5.5 MEDIUM
> CVE-2025-59510 5.5 MEDIUM
> CVE-2025-59511
> CVE-2025-59512
> CVE-2025-59513 5.5 MEDIUM
> CVE-2025-60703
> CVE-2025-60704
> CVE-2025-60705
> CVE-2025-60707
> CVE-2025-60709


https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59505
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59505
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59506
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59506
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59507
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59507
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59508
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59508
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59509
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59509
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59510
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59510
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59511
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59511
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59512
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59512
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59513
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59513
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60703
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60703
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60704
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60704
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60705
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60705
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60707
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60707
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60709
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60709
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> CVE-2025-60719

> CVE-2025-62217

> CVE-2025-62218

Y CVE-2025-62219

Y CVE-2025-59514

> CVE-2025-59515

> CVE-2025-60713

> CVE-2025-60714

> CVE-2025-60715

> CVE-2025-60716

> CVE-2025-60717

> CVE-2025-60720

> CVE-2025-60723

> CVE-2025-60724

9 CVE-2025-62208

> CVE-2025-62209

> CVE-2025-62215

> CVE-2025-62213

> CVE-2025-60706

? CVE-2025-60708

Y CVE-2025-62452

> CVE-2025-60710

> CVE-2025-60718

7.0 HIGH

7.0 HIGH

7.0 HIGH

7.0 HIGH

7.8 HIGH

7.0 HIGH

7.8 HIGH

7.8 HIGH

7.0 HIGH

7.0 HIGH

7.8 HIGH

6.3 MEDIUM

9.8 CRITICAL

5.5 MEDIUM

5.5 MEDIUM

7.0 HIGH

7.0 HIGH

5.5 MEDIUM

6.5 MEDIUM

7.8 HIGH

7.8 HIGH
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https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60719
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60719
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62217
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62217
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62218
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62218
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62219
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62219
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59514
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59514
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59515
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-59515
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60713
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60713
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60714
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60714
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60715
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60715
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60716
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60716
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60717
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60717
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60720
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60720
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60723
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60723
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60724
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60724
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62208
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62208
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62209
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62209
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62215
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62215
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62213
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62213
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60706
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60706
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60708
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60708
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62452
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-62452
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60710
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60710
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60718
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60718
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> CVE-2025-60721 7.8 HIGH

Getroffen producten

Microsoft

Windows 10 Version 1607 for
32-bit Systems

CWE's
CWE Beschrijving
> CWE-59 Improper Link Resolution Before File Access ('Link Following")
> CWE-73 External Control of File Name or Path
> CWE-122 Heap-based Buffer Overflow
> CWE-125 Out-of-bounds Read
> CWE-126 Buffer Over-read
> CWE-201 Insertion of Sensitive Information Into Sent Data
> CWE-269 Improper Privilege Management
> CWE-270 Privilege Context Switching Error
> CWE-284 Improper Access Control
> CWE-325 Missing Cryptographic Step
> CWE-362 Concurrent Execution using Shared Resource with Improper
Synchronization (‘Race Condition')
> CWE-415 Double Free
> CWE-416 Use After Free
> CWE-426 Untrusted Search Path
> CWE-532 Insertion of Sensitive Information into Log File
> CWE-822 Untrusted Pointer Dereference


https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60721
https://vulnerabilities.ncsc.nl/vulnerability.html?id=2025/cve-2025-60721
https://cwe.mitre.org/data/definitions/59.html
https://cwe.mitre.org/data/definitions/59.html
https://cwe.mitre.org/data/definitions/73.html
https://cwe.mitre.org/data/definitions/73.html
https://cwe.mitre.org/data/definitions/122.html
https://cwe.mitre.org/data/definitions/122.html
https://cwe.mitre.org/data/definitions/125.html
https://cwe.mitre.org/data/definitions/125.html
https://cwe.mitre.org/data/definitions/126.html
https://cwe.mitre.org/data/definitions/126.html
https://cwe.mitre.org/data/definitions/201.html
https://cwe.mitre.org/data/definitions/201.html
https://cwe.mitre.org/data/definitions/269.html
https://cwe.mitre.org/data/definitions/269.html
https://cwe.mitre.org/data/definitions/270.html
https://cwe.mitre.org/data/definitions/270.html
https://cwe.mitre.org/data/definitions/284.html
https://cwe.mitre.org/data/definitions/284.html
https://cwe.mitre.org/data/definitions/325.html
https://cwe.mitre.org/data/definitions/325.html
https://cwe.mitre.org/data/definitions/362.html
https://cwe.mitre.org/data/definitions/362.html
https://cwe.mitre.org/data/definitions/415.html
https://cwe.mitre.org/data/definitions/415.html
https://cwe.mitre.org/data/definitions/416.html
https://cwe.mitre.org/data/definitions/416.html
https://cwe.mitre.org/data/definitions/426.html
https://cwe.mitre.org/data/definitions/426.html
https://cwe.mitre.org/data/definitions/532.html
https://cwe.mitre.org/data/definitions/532.html
https://cwe.mitre.org/data/definitions/822.html
https://cwe.mitre.org/data/definitions/822.html
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Windows 10 Version 1607 for x64-
based Systems

Windows 10 Version 1809 for
32-bit Systems

Windows 10 Version 1809 for x64-
based Systems

Windows 10 Version 21H?2 for
32-bit Systems

Windows 10 Version 21H2 for
ARM64-based Systems

Windows 10 Version 21H2 for x64-
based Systems

Windows 10 Version 22H?2 for
32-bit Systems

Windows 10 Version 22H2 for
ARM64-based Systems

Windows 10 Version 22H?2 for x64-
based Systems

Windows 10 for 32-bit
Systems

Windows 10 for x64-based
Systems

Windows 11 Version 22H?2 for
ARM®64-based Systems

Windows 11 Version 22H2 for x64-
based Systems

Windows 11 Version 23H2 for
ARM64-based Systems

Windows 11 Version 23H?2 for x64-
based Systems

Windows 11 Version 24H2 for
ARM64-based Systems
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Windows 11 Version 24H?2 for x64-
based Systems

Windows 11 Version 25H2 for
ARM64-based Systems

Windows 11 Version 25H2 for x64-
based Systems

Windows Server 2008 R2 for x64-based
Systems Service Pack 1

Windows Server 2008 R2 for x64-based Systems

Service Pack 1 (Server Core installation)

Windows Server 2008 for 32-bit
Systems Service Pack 2

Windows Server 2008 for 32-bit Systems
Service Pack 2 (Server Core installation)

Windows Server 2008 for x64-based
Systems Service Pack 2

Windows Server 2008 for x64-based Systems
Service Pack 2 (Server Core installation)

Windows Server
2012

Windows Server 2012 (Server
Core installation)

Windows Server
2012 R2

Windows Server 2012 R2 (Server
Core installation)

Windows Server
2016

Windows Server 2016 (Server
Core installation)

Windows Server
2019
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Windows Server 2019 (Server
Core installation)

Windows Server
2022

Windows Server 2022 (Server
Core installation)

Windows Server 2022, 23H2 Edition
(Server Core installation)

Windows Server
2025

Windows Server 2025 (Server
Core installation)

Disclaimer

The Netherlands Cyber Security Center (henceforth: NCSC-NL) maintains this page to enhance access to its
information and security advisories. The use of this security advisory is subject to the following terms and
conditions: NCSC-NL makes every reasonable effort to ensure that the content of this page is kept up to date,
and that it is accurate and complete. Nevertheless, NCSC-NL cannot entirely rule out the possibility of errors, and
therefore cannot give any warranty in respect of its completeness, accuracy or continuous keeping up-to-date.
The information contained in this security advisory is intended solely for the purpose of providing general
information to professional users. No rights can be derived from the information provided therein. NCSC-NL and
the Kingdom of the Netherlands assume no legal liability or responsibility for any damage resulting from either
the use or inability of use of this security advisory. This includes damage resulting from the inaccuracy of
incompleteness of the information contained in the advisory. This security advisory is subject to Dutch law. All
disputes related to or arising from the use of this advisory will be submitted to the competent courtin The
Hague. This choice of means also applies to the court in summary proceedings.
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